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Practice Management Modules

Time Entry Enter employee time and expenses.

Billing Bill client WIP, calculate fixed fee bills, and
print customized invoices.

Accounts Receivable Enter payments, credits, and debits, and print
client statements and dunning letters.

Projects Set up projects to be completed for clients and

track the progress of a project. An additional
module, Project Tracking, allows you to set the
status of a return, and extend due dates. Project
Tracking can be selected from the Features
menu of each module.

Contact Management View contact information for clients and
maintain client notes.
Administration Set up and maintain firm lists such as client files,

employee files, service codes, and firm
information. Update the system with the latest
invoicing and time entry transactions.

Reports Run reports on client, employee, service code,
project, and scheduling information.

Report Writer Create reports for your firm.

Dashboard View summarized and detailed information for

the firm, employees, clients, and projects.

Minimum Requirements
Please refer to the CCH ProSystem fx Practice Management minimum system requirements
available here: https://support.wolterskluwer.ca/en/support/requirements/system/.

Using Help
F1: If you need help on any option in CCH ProSystem fx Practice Management, press F1 or
use the Help menu. Help also includes the Getting Started Guide.

Host Database Location: To determine the location of your host database, whether or not
you are remote, the date you last imported data, and the version of CCH ProSystem fx
Practice Management you are using, select About on the Help menu.

Who Is Logged On: To view who is currently logged into CCH ProSystem fx Practice
Management, select Active Processes on the Help menu.


https://support.wolterskluwer.ca/en/support/requirements/system/

1 Administration

Creating Your Firm

When you first set up your firm in CCH ProSystem fx Practice Management, follow
these steps to make sure your setup is complete. For information on adding Canadian
requirements to CCH ProSystem fx Practice Management, see Setting Up a Canadian
Firm.

Log on

Start CCH ProSystem fx Practice Management.

Log on as SUPERVISOR, entering your password. Double-click the Administration
option.

Enter your firm information and create one employee.

Go to Security Setup from the Firm menu and give that employee rights to the
Supervisor privileges.
Continue setting up your firm by defining list items and custom fields.

Add a default invoice format

Select Invoice Formats on the Firm menu. Define a default invoice format for your
firm.

Page Size: paper size

Page Format: information that prints

WIP Format: Default format

Date Format: Heading and Body

Custom Text customize standard text.

Custom Fields enter custom descriptions.

Status Descriptions customize the reviewed statuses for invoicing.

Office Options specify which office should be referenced when utilizing office
keywords on invoices.

Format Header change the default

Format Page 2 Header change the default

Format Footer change the default

Reset Fonts to select the font you want to use. (Arial 10 is the default font).

Create your lists/Other

Use the Lists menu found on the navigation bar in Administration to set up your
list items in the following order:

Bank Accounts

Enter the name of the firm’s bank.
Designate the bank when entering payments.
Tie cashs receipts reports to bank deposits.

Departments
Enter the department name
Employees may be grouped by hone department.
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Regions
Enter a Description
Offices may be assigned to regions and region totals can be printed on reports.

Offices
Enter the Name and Address, Telephone, Fax 1 and 2, Internal Reference

Reasons

Enter a Reason Type for Billing adjustments.

Enter a Reason Type for A/R credits.

Reports with reason codes listed can highlight problem areas of the firm.
Examples are BIL and AR to identify the areas of billing and receivables.

Finance Charges
Enter the name of the finance charge.
Determine what qualifies a balance as past due.

Indicate whether the finance charge will be a percentage of flat fee and enter
the amount.

Clients assigned to this finance charge are then eligible for a late charge.

Sales Tax
Enter the abbreviation of the state in which this sales tax applies.
Enter the percentage of tax to be calculated.

Sales tax must be assigned to both service codes and clients or it cannot be
calculations.

A list of summary descriptions is provided for you.

NAIC Codes
A list of NAIC Codes is provided for you.

Line of Business
Use this optional list to create a list of industry codes and descriptions that are
meaningful to your firm.

This allows you to generate reports of clients sorted by Line of Business.

In/Out Status

This list of employee status descriptions (Appointment, Lunch, Meeting, etc.) is
used on the In/Out Log tab of Time and Expense Entry. A group of default status
descriptions is entered for you automatically. You can add, edit, or remove
status descriptions from the list. Use this option to customize the In/Out Log for
your firm’s specific needs.

Note Topics
Enter the topic name and click OK.

Note Topics are used to classify or sort Notes.



Skill Levels
Enter a description for this skill level.

Skill levels identify the staff hierarchy in your firm by level of experience and
responsibility and help you see the productivity percentages of your employees.

Time Entry Custom
Enable this feature in Firm Setup

Enter a code for selection in Time Entry.

This code will be associated with the time or expense transaction and can be
used for reporting (for example, a municipality code for tax reporting).

CPE Categories
Enter a CPE Category description.

These categories will be used when entering CPE information for employees.

CPE Types
Enter a CPE Type description. The types will used to enter CPE credits for your
employees

Project Types
A list of default project types is provided for you.

Add, Edit or Delete any project types for your firm.
Project types allow you to group projects for reporting.

Project Positions
Enter roles that describes the employee task to be performed. (ie. Preparer).

Standard Paragraphs Invoice Paragraph
A list of standard paragraphs is provided for you.

Two types of paragraphs can be setup: invoice or email.
Enter additional paragraphs for your firm.

Entity Types

Entity Type Description

A list of entity types is provided for you. To add to the list, enter an entity
description. Use Entity Types to group like clients together on-screen or in
reporting.

Work Types
Enter a user-defined work type. Examples include Tax and Audit.

Use Work Types to group clients by the type of work you perform.

Affiliate Types

Enter Affiliate Type Description such as attorney, stockbroker, or banker.
Business Affiliates are the people or companies who do business with a
particular client.
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Business Affiliates
Enter the firm name and firm information for your firm’s business affiliates.
These affiliates can then be associated with your Clients.

Custom Fields - Client, Employee, Business Affiliates, Project, Referrals
Enter a description, select a type (such as text or date) and add a default value
(optional). All custom fields are available when entering information for the
specific source.

Contact Categories
Enter the Contact Category description used to identify the contacts set up for
clients in the Client Tracking folder.

Tracking Status
A list of the various stages in tax return preparation used in Project Tracking is
provided for you.

You can modify the list, delete items, or add items.
You can set the status of a client’s return on-screen.

Leads
Enter the lead name and address information, the owner of the lead, and
whether or not the lead is shared with other employees.

Leads provide staff member the ability to work their own list of new business
opportunities without bringing them officially into the list of active clients.

Referrals - Name and Address, Status, Phone, Description
Enter the name, address, status, phone and code for businesses that refer
business to your firm.

Referrals are found under Marketing on the Lists menu.

Mailers

Use the Mailer list (from Marketing on the Lists menu) to link clients, prospects,
business affiliates, leads, and referrals with the various mailings your firm uses.
Enter a name for each mailer. Examples include Firm Newsletter, Audit
Newsletter, and Physician’s Letter.

When you are ready to send a mailing to a designated group, use the Merge
option on the Mailers list (or Quick Labels) to create and print mailing labels.

Marketing Methods

Enter a description for Marketing Methods you use to acquire new clients.
Examples include Newspaper Ad, Firm Sponsored Event, and Nonprofit
Affiliation.



Creating Your Employees

Select Employee Setup under Lists/Employees on the navigation bar in
Administration.

To enter an employee

Enter the Name/Address, profile information, billing rates, cost rate, status and PTO
allowances.

Enter of CPE and Banked Hours from the Tracking button.

Click the Notes button to add employee notes.

Click the Custom button to enter information on custom fields defined in firm setup.

Creating Your Clients and Prospects

The Client list contains information about your firm’s clients and prospects.

Clients who employ your firm for more than one task (such as tax and audit

work) can be set up with engagements (or accounts). If a client has multiple
engagements, set up the client first and then add the engagements.

To enter a client or prospect

Choose Clients from the Lists menu found on the navigation bar in Administration.
Enter all relevant client information on the Client tab. Select French as the invoice
language for French-speaking clients.

Other information includes:

Mailing address, client managers, invoicing and statement information.

Billing Fee information, custom billing rates, client status, and office information.
Contacts, Marketing, Business Affiliates, Sales Tax, or Projects, or to assign a Mailer
to the client available.

To enter additional engagements

On the Client list, select the client for whom an engagement needs to be added and
click the Add Engagement button.

Change any information unique to this engagement on each tab of Client Setup.
Choose one of the client’s engagements as the Master by clicking the Master Client
Folder check box on the Mailing tab of that engagement’s Client folder.

Creating Your Service Codes

Choose Service Codes on the Lists menu found on the navigation bar in
Administration.

Categories and Subcategories are required
These act as group fields for reporting.

Enter up to five characters for the code.

Enter reports description and invoice paragraph.

To add a service code
Enter up to five characters for the service code and then enter a description and
invoice paragraph. Select the French tab to enter a separate French language reports
description and invoice paragraph (if printing French language invoices).
Select the category and subcategory and the Department to which you want to assign
this service code.
Enter all general information for the service code, including the type of work
(regular, sick, etc.).
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Indicate whether the service code is time-based, expense-based, or a reimbursable
expense and enter an invoice paragraph for the service code.

Enter all pertinent service code billing information.

If this is an expense or reimbursable expense-based service code for mileage or other
units of measure, select the Mileage/Units check box and enter the rate per mile or
unit.

If this is a time-based service code, enter any surcharge information.
To assign a sales tax to this service code, click the Sales Tax button. Click Add to add
a sales tax rate to this service code. Select the taxing authority and click OK.

Creating Firm Security

You do not need to make any changes to security unless you want to turn options off
for employees or you want your employees to use passwords.

Security has a built-in default setting. If you decide to change security, we
recommend that you follow these guidelines.

Security guidelines

Log on as SUPERVISOR.

Decide if you want to change the firm default. If not, skip to step 4.

Most firms may want to change the default setting so that all options are turned off
except Staff Time Privileges (time and expense entry) and Contact Management
Privileges as this covers the majority of employees. However, under each of these
categories there are privileges that you may want to deny all employees, such as
Manager Partner Alert or Modify Client Address.

When you change the firm default it becomes the default for all employees except
the SUPERVISOR.

Identify the employees who will have access to the majority of the options in CCH
ProSystem fx Practice Management, such as Billing and Invoicing, Reports, and
Accounts Receivable. Make changes to one of these employees’ security settings and
copy their settings to the other employees who will also have this level of access.

Security settings are saved each time you move from one employee to another.

Setting Up a Canadian Firm

There are several features in CCH ProSystem fx Practice Management that were
designed with Canadian firms in mind. They include calculating QST, printing applied
sales tax, and customizing invoice text. Follow the steps outlined below to set up
CCH ProSystem fx Practice Management in accordance with Canadian requirements.

Customizing Invoice Text

Go to Administration and select Invoice Formats on the Firm menu.

If you would like your GST # to print on every invoice, add it to your invoice footer by
clicking Format Footer. Then select the Print Footer check box on the Page Format
tab.

Or, enter your GST # in the Custom 1 (Custom Fields tab) and pull the keyword Firm
Custom#1 onto invoices in Billing.



Select the Custom Text tab and change the text on your invoice to read "GST" or
"General Sales Tax" instead of Sales Tax. You can also change Sales Tax Applied to
"GST Applied."

Calculating Sales Tax

Go to Administration and select Sales Tax States from the navigation bar.

Set up a sales tax called GST and enter the GST tax rate.

Open the Client Tracking folder for all clients subject to this tax and select the Sales
Tax tab. (From the navigation bar in Administration select Lists/Clients/Tracking
Folder.)

Click New and select GST from the drop-down. Enter the sales tax rate to calculate
on progress bills.

If the client is subject to a Provincial Sales Tax on invoices, enter the PST rate.

If the client is subject to Quebec Sales Tax, select the Include GST check box to
calculate tax on services and the GST.

Finally, open each Service Code that is subject to sales tax and click the Sales Tax
button. Select GST as the sales tax that will calculate on the service code. (From the
navigation bar in Administration select Lists/Service Codes.)

Formatting the Invoice

Once you bill a client, you'll need to add some items to the invoice. Repeat these
steps for each client subject to GST.

Generate the invoice and click the Format Options button.

If you have included your GST # in your invoice footer, be sure that the Print Footer
check box is selected.

To print sales tax collected on progress bills separately, do not select the "Net Sales
Tax Applied with Sales Tax" check box. Click OK.

If you added your GST# as a Firm Custom field, pull the keyword FirmCustom#1 onto
the invoice.

When you exit the Invoice window, be sure to save the current settings as the
default. This will apply the format options you selected in steps 2 through 4 to every
invoice you generate for the client.
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2 Main Menu

TIME ENTRY

BILLING

ACCOUNTS RECEIVABLE
CONTACT MANAGEMENT
ADMINISTRATION
REPORTS

REPORT WRITER

Click on any of the Dashboards in the left navigation bar to access those dashboards.

Firm Dashboard
By Primary Partner
By Secondary Partner
By Bill Manager
By Responsible Person
By Manager
By Tax Reviewer
By Tax Preparer
Employee Dashboard
Project Dashboard
Resource Dashboard
User Options
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3 Time Entry

Entering Time and Expenses

Date

Select the date from the Calendar.

The date you select is the transaction date for the entry.

Time and expense entries are released and posted by transaction date range.

Client Name/Code

Type the first characters of the client or prospect’s sort name.
The Client list appears as soon as you enter the first character.
Enter the client code if you prefer to lookup using the code.

Use the slash to switch between searching by name and by code.
To view all clients, use the drop down

Project

Firm Setup

In the Firm Setup on the Time Entry tab, there is a checkbox to require the selection
of a project when entering time.

If this checkbox is checked then you may also require a project for non-billable
clients.

Project Based Time Entry

When users are setup for Project Based Time Entry in security, the project displays
before the service code.

When setting up Project Types you may associate one or more service codes with the
project type on the Link Service Code tab. These service codes will be the only
service codes available if a project type selected. For example, select all the 1040
codes for an individual tax return project type.

Additionally you may set the employee bill rate # for this project type.

Project Lookup
The projects are displayed until the milestone date for delivered has a date.
The project set up must have the checkbox checked to display in Time Entry

Service Code

Type the first characters of the category or Subcategory or Service Code to view an
abbreviated selection list.

The lookup searches all Categories, Subcategories and Service Codes for the
characters typed.

Time

For time service codes, enter the number of hours the employee worked.

Enter the decimal point for fractions of hours.

The number of hours is multiplied by the appropriate billing rate (plus any surcharge)
to calculate WIP.
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Rate

If you chose a TIME service code, the employee’s HOURLY rate for the service code
billing level is used to calculate WIP.

If the Client has been set up with a special rate, that rate will be used instead of the
standard billing level.

This rate only appears if the rate is marked to display in Employee Setup.

Expense Using Service Codes designated as Units

For mileage/units expense the column heading will change to Units.

Enter the number of units (miles, copies, etc.) incurred in the expense.

The units entered are multiplied by the rate (entered in Administration/Lists/Service
Codes) in the calculation of the expense.

Expense Service Codes

If you chose a regular expense service code (not designated for mileage/units), enter
a flat amount.

Enter the decimal point if you are entering dollars and cents.

Timesheet Preferences
Service Code Lookups for Time Entry: You may designate your list of service codes
that you use from the Timesheet Preferences.

Time Entry Custom

Time Entry Custom field can be optional or required.

To make it required go to the Firm Setup.

The list of valid entries for this field is set up in the Administration module > Lists >
Other

Click the drop-down to show a list of Time Entry Custom descriptions and codes.

If this option was required (in Firm Setup) you must select one custom code from the
list for each time and expense transaction entered.

"No Selection” is not an entry option if the Time Entry Custom field is required.

This field will default from the last entry made.

Memo

If you want any notes associated with this entry enter them in the Memo window.
This memo can be marked as internal.

Click Save to complete the entry.

You can view Time Entry memos in Billing and Invoicing.

Release

Edit and Post Update Mode is the default method for releasing time. The entries are
released from Time Entry, reviewed and edited through Edit Released Time, and
Posted to Work-in-Progress through Update Time in Administration.

Real Time Update Mode is assigned in Security Setup for employees. If the user is
assigned Real Time, the entries are released and posted in one step, removing the
Administrator’s involvement in the posting process.

Batch Entry of Time and Expense by Administration:
If an administrative staff member enters all employee timesheets, all work can be
done using Batch Time Entry in Administration.
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Time Entry Grid
Entries are identified with “U” (Unreleased) prior to being released and with “R”
(Released) once they are released and posted.

Special Codes

Marketing Information

If you enter time for a Marketing service code (set up in Administration/Service
Codes with a Marketing type) the Marketing Information window

Use the Marketing Log tab to enter detailed information about the marketing
event. You can track time spent on leads as well as clients, prospects, referrals,
or business affiliates.

Use the Add Marketing Tickler tab to enter reminder information that can be
printed on reports and displays on the Due Dates tab and in the Appointment
Manager in Time Entry, and in Client Notes.

CPE Information
If you enter time for a CPE service code, the Employee CPE Credit window
displays if you retained the firm default to prompt for CPE information.

Use this window to enter CPE credit hours and class information.

Time Entry Folder

Enter time or expenses Tab
Use the Time and Expense Entry tab to enter time and expenses.

Due Dates Tab
To view only Projects to which the employee has been assigned within the
selected date range, select Project Due Dates from the View drop down.

Project Due Dates, Personal Tasks, Marketing Ticklers, Follow-Ups &
Appointments for the logged on employee are listed on the Due Date Tab.

Timesheet Lookup Tab

Select from the drop-down for the type of posted hours to view (all hours,
banked, used, sick, vacation, CPE, holiday, personal, marketing, nonbillable,
other nonbillable, billable, or summary).

Alerts Tab

View, review, or dismiss the alerts that have been generated for the current
employee

from the Alerts tab.

In/Out Log Tab
Use the In/Out Log tab to let co-workers know if you are available or not.

WOLTERS KLUWER



Printing the Time Exception Report (Administration )

The Time Exception Report prints the amount of hours entered by employees for a
specific date range. Use the report to determine which employees have not entered
time. This report can be selected from the Administrative Activities window or the Edit
Lists menu in Reports.

Editing Released Time (Administration )

You can edit or delete any transactions that have been released but not yet posted using
Edit Released Time. Although other options are available in Edit Released Time, you
should use this option ONLY to edit entries that were released incorrectly. This option is
available to administrators who are running remote and are connected to the host.
Entries that were posted using Real Time Update Mode in Time Entry are not available
for editing via this feature.

Updating Time (Administration )

Posting Time updates WIP with time and expenses entered in Timesheet or Batch Entry.
Time and expenses must be posted to WIP before they appear on billing worksheets and
on billing windows.

Keep a current backup in case of a power failure during a post. If a power outage occurs
during a post, you should restore the backup and re-post.

Administration - Correcting Posted WIP

Use Correct WIP to correct any transactions posted to WIP. You can change the client to
whom time entries are posted, change the service code on a transaction, or delete the
transaction. You cannot change WIP amounts directly but the hours or expense amounts
as well as the rates utilized can be adjusted.
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4 Billing and Invoicing

Billing Your Clients

Billing and Invoicing allows partners or billing managers to review and bill clients. If
you are designated as a partner or billing manager, you may use Billing and Invoicing
to choose the clients and amounts to bill on-screen.

To use Billing and Invoicing

Print billing worksheets or bill on-screen.
Select items to bill.

Generate invoices.

Final print invoices.

Update (post) invoices.

Billing and Invoicing

View a list of clients
If you are a bill manager or partner, your clients are automatically listed.

You can access a list of clients for other billerts and partners from the Edit
option on the menu bar.

Select client criteria (clients with WIP greater than zero, fixed fee clients, or all
clients).

Review for selection
Sort clients by clicking column headings.

You may also set your preference for which columns display and the order in
which they display. Select My Column Billing Order from the Preference menu.

Review WIP on-screen
Select the client. The Bill button displays a list of WIP that has not been billed.

The navigation bar on the Billing Selection window allows you to filter WIP
entries, giving you more flexibility when billing clients.

WIP can be filtered by Service Code category, subcategory, expense, or project.
This allows clients to be easily billed for an entire project.

You may also break the entries into billable time and expenses, if expenses
have been entered.

Use the navigation bar to select the WIP you would like to display.

To show more detail, select the appropriate button along the bottom of the
window.

Bill all WIP
Select the Quick Bill button. Enter the billed amount or percentage, writing the
bill up or down if you wish.

Bill selected WIP
Mark the transactions you want to bill in the Bill column.
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Enter a write-up/down

After selecting the transactions to bill, select the Adjust Selected button and
enter the adjusted billed amount or percentage to adjust all selected
transactions.

Enter a partial bill
Select a WIP transaction (or select Category for a group of transactions) and
select the Partial Bill button. Enter the amount or percentage you want to bill.

You can also enter either a write-up or write-down.
This option provides the ability to leave remaining WIP.

Enter a progress bill

Select the Progress Bill button and enter the progress bill amount. This creates
a credit against WIP. The client receives an invoice for the amount specified but
the amount is carried against all of the WIP. Reports show the gross WIP, the
credit against the WIP and the net WIP.

Bill a billing agreement

All billing agreements set up for the client (in Clients/Billing Fees) display in the
navigation bar under Billing Agreements. They are sorted by frequency. Select
the agreement to bill all WIP associated with it.

Review client billing

After making your billing selections, select the Recap Billing button. If you want
the Billing Recap window to automatically appear when generating invoices,
select the Display check box on the Billing Recap window.

Enter a reference, Designate a reason, Allocate to the firm
Select the Recap Billing button on the screen when marking the transactions to
bill.

Enter an invoice reference that will appear with Prior Invoice information on-
screen and on billing worksheets.

Select the reason drop-down arrow to select the reason you want associated
with this write-up/down. (Reasons are set up under Lists/Other on the
navigation bar in Administration.)

Select the Recap Billing button. Select the Firm Allocation check box to allocate
the write-up/downs to the firm rather than the employee.

Override sales tax

Select the Recap Billing button and select to override the calculated sales tax.
You can override the sales tax on services, additional sales tax (such as the
PST), or any applied sales tax.
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Review prior invoices
Select the Prior Invoices button. Prior invoices are listed in a grid.

To view the WIP that made up an invoice, select the invoice and click Invoice
WIP.

To view the actual invoice, click View Invoice.

Correct WIP

If you need to correct WIP during the billing process, click the Correct WIP
button.

You can then either correct or delete WIP, correct WIP projects, or correct WIP
detail.

Generate an invoice
Select the Generate Invoice button to generate the invoice.

You can edit it on-screen if you wish.

The Generate Invoice button switches to Review Invoice once an invoice has
been generated for the client.

Print an invoice
Select Print Edit from the Invoice window to print an edit invoice without the
invoice number and date.

Select Print Final to print a final invoice with an invoice number and date.
Select Save/Exit to save the invoice.

To e-mail an invoice to the client, select either the Email only or the Print and
email option after the invoice is selected for final print.

Number an invoice

When transactions are marked for billing on the WIP Selection screen and the
window is closed or an invoice is generated, an invoice number is assigned. If
the billing is canceled before leaving the screen, the invoice number is not
generated.

Bill a fixed fee
Select Fix Fee from the Select Client List. You can invoice the fixed fee clients
one at a time from this screen.

Click F1 for keystrokes in Help

Add Client Notes

Select Client Notes from the Billing window to add, edit, delete, or print note
entries.

There is a Note Type “Billing” to designate billing notes. If a Billing note within
the last twelve months exists, the label for the button will be italicized and
red.

WOLTERS KLUWER
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Archived Invoices

When invoices are final printed, they are archived. Archiving saves a compressed
copy of the invoice electronically in an archived file. You can then reprint the invoice
at a later date for audit or review.

To view or print archived invoices from the Billing window

Select the reason drop-down arrow to select the reason you want associated
with this write-up/down. (Reasons are set up under Lists/Other on the
navigation bar in Administration.)

The Prior Invoices button on the Billing window to view invoices for the current
client.

To view or print archived invoices from Contact Management

Search for the client whose invoices you would like to view and click the Invoices
tab.

Reversing Bills

Reverse Billings allows you to reverse transactions billed in error. Invoiced
transactions are restored to WIP and the invoice is deleted from Accounts
Receivable. Any payments made against the invoice remain in A/R but are moved to
Later Distribution. The invoice is marked as reversed in the archive file.

To reverse billings

Select Reverse Billings from the Administrative Activities window in Administration.
Enter the Invoice Number for the invoice you wish to reverse and press TAB.
Select F1 for keystrokes in Help.
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5 Accounts Receivable

Recording Payments and Sending Statements

Payment distribution method declared in Firm Setup
Open item:

Open item payments are applied to specified invoice(s) or finance charge(s).
Balance forward:
Balance forward payments are applied to the oldest invoice (or finance charge).

In either case, you can apply payments to invoices or finance charges of your choice.

To use Accounts Receivable

Enter payments and memos.

Post payments and memos.

Apply any unapplied payments and memos.
Calculate and post finance charges.

Set up statements.

Print or e-mail statements.

Print dunning letters.

Accounts Receivable Menu Options

Enter payments/memos

Select Enter Payments to enter payments, credit memos, debit memos, bad
debt write-offs, and adjustments.

First, enter payment information (employee, deposit date, transaction type,
bank/reason, client, amount, check/document # and date) and then click
Distribute. The distribution window appears so you can distribute the entry
accordingly.

If you are not ready to apply the payment, you can mark it for Later
Distribution. Select Apply Later Distribution on the Accounts Receivable window
when you are ready to apply the payment.

To add or review entries for another employee select the employee from the
drop-down list.

Print deposit slip
Select Print Deposit Slip if you want to print optional deposit slips for bank deposits.
Select F1 for keystrokes in Help.

Update A/R
Select Update A/R to post payments, memos, and write-offs. This updates A/R
and statistical files for reporting.
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Apply service charges
Select Calculate Finance Charges to calculate service charges on overdue
accounts.

Select F1 for keystrokes in Help.

Print/E-mail statements

Select Print/Email Statements to print or e-mail statements for clients.

To set up statements, select the Page Format, Print Criteria and Page Setup
tabs and establish format, criteria, and print settings.

To print statements, select the sort from the navigation bar.

Then select the Criteria tab to enter aging criteria. If you do not want to
generate a statement for clients with a current invoice, enter a cutoff date for
invoices.

Enter the statement dates.

Then use the additional tabs to print by your sort option.

Finally, click Print/Review or Print All. Select one of the e-mail output methods

on the Printer Selection window to send the statement to the client as an e-
mail attachment.

Print dunning letters
Select Dunning Letters to create and print letters to notify clients that their
account is past due.

Use one of the template letters provided for you or create and use custom letters.
Select F1 for keystrokes in Help.

Distribute later
Select Apply Later Distribution if you don’t know the invoice to apply the
payment against and then apply the payment when you know the invoice.

Correct posting errors
Select Correct A/R to correct a posted A/R transaction. Enter the client, entry
type, and a date range.

Select F1 for keystrokes in Help.

View A/R totals
Select Lookup A/R to view A/R on-screen. Enter a client name or code and a
date range for transactions.

Enter A/R Notes

Select A/R Notes Entry to add or view notes associated with specific A/R
transactions for a selected client. You can add, edit, delete, or print the
entries. Notes can be entered here, or from Enter Payments.

Correcting A/R

Payments, memos, write-offs or adjustments posted in error to Accounts Receivable
can be corrected or deleted. Follow these steps to correct client information or
redistribute an entry.
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To correct client information

Select Correct A/R on the Accounts Receivable window. Enter the client name or
code (preceded by a period or slash) of the client whose account you need to
correct. Select the transaction you wish to correct and click Correct Client.

To distribute an A/R entry to a different invoice

Select Correct A/R on the Accounts Receivable window. Enter the client name or
code (preceded by a period or slash) of the client whose account you need to
correct.

Select either A/R Entries or Finance Charges as the Entry Type.

Enter a date range to narrow the search further.

Select the transaction you need to redistribute and click Redistribute.

Setting Up Statements

Use this option to create a default statement format for your firm. Statements can
be printed or e-mailed in addition to invoices if you wish. Statements include
payments, memos, write-offs, finance charges, and invoiced amounts. Statements
print in portrait mode.

To set up the statement format

Select the Print/Email Statements option on the A/R window.
Select the format style, either Balance Forward or Open Item, on the Format tab.

Open the Print Criteria, Format, and Page Setup tabs to enter the page setup. You
can also establish the format for the statement header (Format Header button) and
footer (Format Footer button). Choose the keywords for your firm and client
information that you want to print on statements. Position the keywords where you
want the information printed and choose the desired fonts.

Only set up the footer if the print footer check box is selected.

Printing Statements

Once the default format has been established, you can print statements.
First, set up the dates for the statement calculation on the Criteria tab. Then select
the Print Criteria tab to select the statements to print.

To print statements

Select the Print/Email Statements option on the A/R window and click the F1 key to
bring up and follow the steps listed in Help.

To email statements

The email option is available from the Printer Selection window when printing
statements. Follow the steps listed in Help.
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6 Contact Management

Managing Your Contacts

Contact Management is an on-screen inquiry and analysis tool that gives you quick access
to a variety of client and prospect information.

Contact Management Folder

Preferences

Select Preferences in the menu bar for any tab in the Individual Client Lookup or for
any other node within the navigation bar to customize the available columns to suit
your needs.

View Mailing address
Select the Mailing tab to review mailing information.

Select Edit Client Address to change the client’s mailing address.

View contact information
Select the Contact tab to review the information for each client contact that
was set up in the Client Tracking folder.

View business affiliates
Select the Affiliate tab to view business affiliate information and contact
information for your client’s banker, lawyer, or other business associate.

Review unbilled WIP

Select the WIP tab to view Work-in-Process that has not been billed for this
client. You can also select to include history (invoiced WIP). Add invoice number
for billed WIP.

Identify problem accounts
Select the A/R tab to view detailed history for this client.

Select the Open AR Balance Only checkbox to show only those items on which
an outstanding balance is owed.

If the invoice was archived and you want to view or print it, click View Invoice.

Review past invoices
Select the Invoices tab to view invoice history for the client.

View or update client projects

Select the Projects tab to view the due date projects that have been created
for this client.

Select Tracking Status to view or update the project status or to mark an
employee’s task as completed.
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Check personnel

Select the Staff tab to review the personnel assigned to the client. Information
in the list can be customized by selecting Preferences in the menu bar. These
staff assignments are made in Client Setup.

View information
Select the Profile tab to view general client information.

View or add notes

Click the Notes button on the Contact Management folder to select notes.
Notes, marketing ticklers, follow-ups, and appointments entered here can be
viewed from Time Entry, Billing and Invoicing, Client Setup or on the Features
menu.

Display Lists

Select List of Clients, Client Contacts, Business Affiliates, Business Affiliate
Contacts, Referrals, Referral Contacts, My Leads, or My Lead Contacts from the
navigation bar to display the list of each. This list can be sorted by the primary
sort selected on the navigation bar. Once selected, use the list to display
individual information, send a Quick Letter, generate Quick Labels, or send an
e-mail message.

Add and edit leads

Use Setup Leads to create lead information for new business opportunities.
Leads can be added in Administration, Contact Management and also from the
Marketing Tickler and Follow-up windows (available with Client Notes, Time and
Expense Entry, and Appointment Manager)

Create Letter

Select the Quick Letter option in Options to create and generate a quick letter
to the selected client, client contact, business affiliate, business affiliate
contact, referral, referral contact, leads or lead contacts.

Quick Labels

Select the Quick Labels option from Actions to create and generate quick labels
for the selected clients, client contacts, business affiliates, business affiliate
contacts, referrals, referral contacts, leads or lead contacts.

Send E-mail

Select the Send Email option from Actions to create and send an e-mail message
to the selected clients, client contacts, business affiliates, business affiliate
contacts, referrals, referral contacts, leads or lead contacts.

Load Contacts

Select Sync to Outlook (File menu) to load client Contacts from CCH ProSystem
fx Practice Management into Outlook.

Make your client selection and click the corresponding button. Contacts will be
loaded into your Outlook address book, complete with the name, address,
phone numbers, etc., you entered in CCH ProSystem fx Practice Management.
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7 Project Management

Managing Projects at Your Firm

Project Management is one of the optional features of CCH ProSystem fx Practice
Management.

Reports dealing with Project Management are available on the Due Date, and
Projects tabs of Reports. Due dates are not tied to your firm’s fiscal year and may be
entered for any year.

To create Projects

Create Lists.
Prompt Employees check box then requires the project prompt in Time Entry.

Templates
Quick set up

Copy
Copy a project from one client to another client.
Create projects
Required information
Project Type, Description and Dates
Prompt in Time Entry
Optional Entry
Budgets Hours and Dollars
Employee Bill Rate # to be used for WIP
In Charge
Note
Non-recurring
Custom, Tracking Status and Detail Tasks

Project frequencies

Set if there are repetitive due dates during the year.

Set up hours and expected revenues and assign employees if you want detail.
Schedule the hours for the employees assigned to the project.

Navigation Bar Options

Track Projects
Project Tracking allows you to:

e Track the status of a project , mark a task completed, locate the
employee who last worked on the project, and extend projects that are
past due.

Extend Projects

To extend due dates, go to Extend Projects. (This can be found on the
navigation bar found in Project Tracking or Project Management.) Once the
extension date is selected, extension forms can be printed for each client.
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View employee projects
View the projects that have been scheduled or assigned to an individual
employee or view the entire staff’s scheduled hours for any week selected.

Roll multiple projects
Select Roll Projects to New Year from the navigation bar. Select the original
due date range of the projects you would like to roll.

Select the sort criteria. From the list of available projects, select the project(s)
you want to roll or right-click and Select All. When you are ready, click Roll to
New Year.

Utilities
View Clients without Projects
View Duplicate Projects

Delete Projects by entering a due date range for the projects you want to
delete.

Project Tracking

Track Projects

Select the primary criteria, the date type, date range, and the secondary
criteria to view client projects. All client projects meeting the selected criteria
are displayed. Select a project to locate the project file or to update the
project status.

Project File Locator

Click Project File Locator to view all current WIP for the category and date
range entered for the client associated with the project. Using this information,
you can see which employee last worked on the project and the amount of WIP
posted to the project.

Self Assign

When displaying projects in the Track Detail Tasks view, the Self Assign option
is available when selecting project list criteria By Assigned Position (with the
exception of By ALL). Use this to assign yourself to the selected position for the
selected project or projects, if the position has not yet been assigned. Security
must be enabled for Self Assign and is available in the Project Tracking
(Dashboard) Privileges section of Security Setup.

Set Project Status

Click Set Project Status to view or update the project status or mark an
employee position on the project completed. Select the new project status on
the Project Status tab. If appropriate, enter the received, prepared, reviewed,
completed, or delivered date.

The Assigned Employees tab lists all employees assigned to the project. Use this
tab to review project employees and mark the employee project position as
completed. Click Mark Completed. Enter the completion date. Click Mark
Completed to mark the employee position completed on this project as of the
date entered.
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Extend due dates

Select Extend Projects from the navigation bar in Project Tracking. Select the
Project Type and original due date for the project you need to extend, then
click List Projects. Clients with the selected project type and due date appear
on the grid.

You can extend all clients (right-click and Select All), or select individual
clients. Once the clients are selected, click Extend Project(s).

Select either the 15t or 2" extension option. If you want to override the date,
select Override Date and enter the new extension date.

Print Extension Forms

Federal Extension forms can be displayed on-screen or printed for the extended
client project.

To print extension forms, enter the appropriate form. And click Extend
Projects.

You can select to print forms with client information, print blank forms, display
blank forms, display blank forms or display interactive forms with client
information.
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8 Marketing

Marketing Your Firm

CCH ProSystem fx Practice Management allows you to track marketing methods used
by your firm and determine how your firm attains new business. Marketing methods
such as referrals, mailers, and advertising are available in reporting, showing the
most profitable methods by which your firm acquires new clients.

To use marketing features

WD =

Create referrals and marketing methods.
Record how new clients are acquired.
Create prospects and leads.

Create and designate mailers.

Print mailer labels.

Marketing Options

Create prospects

Choose the Clients option from the Lists menu found on the navigation bar in
Administration. Create a prospect as you would a client, being sure to designate
the status (on the Status/Office tab) as Active Prospect.

Change a prospect to the status of Active Client when appropriate.

You may enter time and expenses for prospects as you would clients; while you
can invoice a prospect, you cannot record A/R.

Record referrals, etc.

Using the Marketing tab of the Client Tracking folder, record how you acquired
a new client. Employees, referrals, and marketing methods are available on
lists.

Track new business

On the Marketing tab of the Client Tracking folder, you may designate a new
client as new business or an engagement as expanded business. This option
allows you to track whether the majority of your business is new or expanded.

Designate mailers

Mailers are created from the Marketing feature on the Lists menu found on the
navigation bar in Administration. Once they are created, you may designate
clients, prospects, referrals, business affiliates, or leads to receive a mailer,
from the Mailing tab of the Tracking folder or from the Mailer feature found on
the Lists menu on the navigation bar in Administration. You may send a mailer
to all members of the selected group or to a particular few within the group.

To assign all types to the same mailer, select All Types.
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Print mailing labels

Print labels using Quick Labels or Word’s mail merge option. Click Merge on the
Mailers list to open the Merge Document Interface window. Click Merge Setup to
set up labels and run the mail merge.

You can set a default merge document by clicking Default Document Setup and
then use this default document to quickly generate future labels by clicking Use
Default Document.

Click Quick Labels on the Mailer List menu to quickly create basic mailing
labels. Select the type of label and click the fields you want to include to set up
the label. The label set up can be saved by clicking Save Format.

Designating Mailer Recipients

Once Mailers are defined, you may designate certain clients, prospects, referrals,
business affiliates, or leads to receive mailers. To print labels for a designated
mailer, click Merge. Click F-1 for specific instructions.

Setting Up the Mail Merge

Once you have designated a group of clients, prospects, and/or referrals to
receive a mailer, select Merge on the Mailers list. Use the Merge Document
Interface window to set up labels, run the mail merge, and set a default merge
document. Click F-1 for specific instructions.
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9 Standard Reports

Practice Management Reports Booklet
The Reports Booklet lists all of the standard reports with a description and an image

of a page from each report.
The Reports Booklet is shipped with each release and you can find it by looking under
CPAS > VPM > DOC on the drive where you have installed Practice Management.

If you have any questions, contact Customer Support at 1-800-268-4522 or send an e-mail
to csupport@wolterskluwer.com.
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